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Important User Notices 

Copyright  1991-2010 Delcam plc. All rights reserved. 

Delcam plc has no control over the use made of the software 
described in this manual and cannot accept responsibility for any 

loss or damage howsoever caused as a result of using the software. 
Users are advised that all the results from the software should be 

checked by a competent person, in accordance with good quality 
control procedures. 

The functionality and user interface in this manual is subject to 
change without notice in future revisions of software.  

The software described in this manual is furnished under licence 
agreement and may be used or copied solely in accordance with the 

terms of such licence. 

Delcam plc grants permission for licensed users to print copies of 
this manual or portions of this manual for personal use only. 

Schools, colleges and universities that are licensed to use the 
software may make copies of this manual or portions of this manual 

for students currently registered for classes where the software is 
used. 
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PartMaker is the world's leading CAM system for automating the 

programming of multi-axis Turn-Mill centers and Swiss-type lathes. 

PartMaker automates the tedious task of manual part programming 

by providing an easy-to-use graphical interface and powerful tools 
and features. 

With PartMaker you can quickly define part geometry, cycle, tool, 
and material information, and all other parameters associated with 

machining a part. What's more, you can also save frequently used 
tool, cycle, and material information in a database to recall and 

reuse at any time. 

Acquired by Delcam plc in 2006, PartMaker Inc. is a wholly owned 

subsidiary of Delcam plc. the world’s leading developer and supplier 

of complete CAD/CAM software solutions. 

About this guide 

Use this guide to find out about: 

 PartMaker system requirements (see page 2) 

 What's new in PartMaker 2011 (see page 4) 

 Accessing help and support (see page 20) 

 

Introduction 
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This section lists the minimum, and the recommended, system 

requirements for PartMaker 2010 and higher. 

Make sure the computer at least meets the minimum system 

requirements (see page 3) before you install PartMaker. However, 
to achieve optimal performance, the computer should meet the 

recommended system requirements (see page 2). 

The following operating systems are supported: 

 Windows XP 

 Windows Vista 

 Windows 7 (use of Window 7 64-bit versions are recommended) 
 

Recommended requirements 

The recommended system requirements for PartMaker are: 
 

 Standard 
PartMaker 

Parasolid 
Import 
Module 
(Solids) 

Full 
Machine 
Simulation 
(FMS) 

Surface 
Machining 
Wizard 
(SMW) 

PowerMILL 
Companion* 

Processor Pentium 3 

800 MHz 
or higher 

Pentium 3 

800 MHz 
or higher 

Pentium 4 

3 GHz or 
higher 

Intel Core 

Duo 
processor 

or higher 

Intel Core 2 

Duo P8600 
or higher 

Memory 
speed 

512 MB or 

more 

1 GB or 

more 

2 GB or 

more 

4 GB or 

more 

4 GB or 

more 

Hard drive 40 GB 40 GB 40 GB 80 GB 120 GB 

Independent 
video card 

128 MB 

NVIDIA 

128 MB 

NVIDIA 

512 MB 

NVIDIA 

1 GB 

NVIDIA 

1 GB 

NVIDIA 

* Processor must support SSE2 Instruction Set for PowerMILL Companion. 
 

System requirements 
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Minimum requirements 

The minimum system requirements for PartMaker are: 
 

 Standard 
PartMaker 

Parasolid 
Import 
Module 
(Solids) 

Full 
Machine 
Simulation 
(FMS) 

Surface 
Machining 
Wizard 
(SMW) 

PowerMILL 
Companion* 

Processor Pentium 3 

800 Mhz 

Pentium 3 

800 Mhz  

Pentium 4 

2 GHz 

Pentium 4 

3 GHz 

Pentium 4 

3 GHz 

Memory 
speed 

512 MB  512 MB 1 GB 2 GB 2 GB 

Hard drive 20 GB 40 GB 40 GB 40 GB 40 GB 

Independent 
video card 

128 MB 128 MB 256 MB 512 MB 512 MB 

* Processor must support SSE2 Instruction Set for PowerMILL Companion. 
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PartMaker 2011 offers all of the original features of PartMaker 2010-

SP1, but with numerous improvements. 
 

Installation 

PartMaker 2011 includes several enhancements to the way in which 

PartMaker is installed on a standalone PC or on a network. 

Changes to the installation process 

Key changes to the installation process are as follows: 

 You can select the language used on the Installation wizard's 
screens. The wizard also installs a localized version of PartMaker, 

if this is available for the language you selected. 

 

 PartMaker now uses different folders for the PartMaker 
application files and your User Files (such as .JOB files). By 

default, the application files are installed to: 

 C:\Program Files\Delcam\PartMaker_2011 for 32-bit computers 

 C:\Program Files (x86)\Delcam\PartMaker_2011 for 64-bit 

computers 

The default folder for User Files is C:\Partmaker. 

What's New in PartMaker 
2011 
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However, you can specify different folders during the installation 

process if you wish: 

 

 Delcam Exchange, Delcam's CAD translation software and 

viewer, is now installed as part of the installation. To find out 
more about this product, see the Delcam Exchange website 

(http://www.ps-exchange.com/). 

Network installations 

PartMaker 2011 provides a new network implementation of 

PartMaker that uses the standard Delcam method of product 
licensing. The product is licensed, using a combination of a dongle 

(which plugs into a USB or parallel port on the computer) and a 
Product Authorization File (PAF), which you install onto the 

computer.  

Using a PAF-protected version of PartMaker offers several 

advantages, including the ability to download updates for PartMaker 
and any licensed post processors from within the PartMaker 

application. 

A separate network installation (PartMaker v2011-H) is available for 

existing network installations that use NetHASP licensing.   

 The installation folders for PartMaker 2011-H remain the same 
as for 2010-H,; that is, both system and user files are 
installed into C:\PartMaker. 

Users of Pro/E and AutoDesk Inventor View 

Instructions on how to set up these applications for use with 
PartMaker 2011 are now provided on the PartMaker installation CD, 

as described in Working with solids (see page 12). 
 

http://www.ps-exchange.com/
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Using Bar-Fed Mill machines with 
PartMaker 

PartMaker/Turn-Mill 2011 offers the ability to program parts for 
machining on Bar-Fed Mill (BFM) machines. These machines are 

usually equipped with a Bar Feeder, a Tool Head and a Tool Changer 
and are a popular choice for companies producing small, complex 

parts. 

Instead of a sub-spindle, BFM machines have a work-holding device 

that is capable of various orientations. PartMaker users familiar 
terms to describe these work-holding devices; namely, collet, chuck 

and vise. 

To support programming of a BFM, the Spindle Settings dialog has 

been changed so you can now specify a Machine Type of Turn-Mill or 

Bar-Fed Mill: 

Machine Type of Turn-Mill 

 Work Holding allowed on either spindle is Collet or Chuck: 
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Machine Type of Bar-Fed Mill 

 Work Holding allowed on the Main spindle is Collet or Chuck. 

Work Holding allowed on the Sub- spindle is Collet, Chuck or 
Vise: 

 

 When you click the Vise Data button on the Spindle Settings 

dialog, the Vise Data dialog is displayed: 

 



 

8 • What's New in PartMaker 2011  PartMaker 2011  

 When a Vise is selected as the sub-spindle Work Holding, an icon 

appears in Setup dialog to the right of the Settings button for all 

sub-spindle faces. For example: 

 

 Clicking this icon displays the Sub-Spindle Machining Position 

dialog. Use this dialog to enter the distance between spindles 
during machining (Machining Distance (W)), as well as the Sub-

Spindle Orientation Angle of 0 or 90 degrees: 

 

 Additional options to configure Full Machine Simulation (FMS) for 
BFM machines are available in the Sub-Spindle Properties dialog 

for users creating FMS kits. 
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Tool enhancements 

PartMaker 2011 includes several enhancements to tools. 

Improved tool management with a master tools database 

PartMaker 2011 introduces a Master Tools Database file. This 

enables your company to manage its tool inventory in a single file, 
which is saved as a comma-separated values (.CSV) file. Using an 

external database program, such as Microsoft Excel, employees who 
are not familiar with PartMaker can easily manage your tool 

inventory, if required. 

 You must license the Advanced Tools module to use this 

feature. 

Once your Master Tools Database file is set up, you can quickly 
import tools from this file into a PartMaker Tool Data file (.TDB), 

before you start programming a part. Similarly, if you create new 
tools in PartMaker you can easily export these tools from PartMaker 

into the Master Tools Database file. To manage the transfer of tool 
data between files, use the new Manage Tools Files dialog: 

 

  Displays tools stored in the Master Tools Database file. 

  Displays tools stored in the PartMaker Tools Data file. 

  Use the buttons on the dialog to transfer tools between files. 
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Specifying a programmable tool inclination 

In PartMaker/SwissCAM and PartMaker/Turn-Mill, you can now 

specify a programmable tool inclination for live, fixed-angle tools for 
machines that do not have an articulated Tool Head. Such tools can 

be used on Turn-Mill or Swiss machines.  

The new options for specifying a programmable tool inclination are 
on the Tool Properties dialog. The values you specify are used in Full 

Machine Simulation and post processing 

 

More tools provided as standard 

In PartMaker 2011 the following tools are provided as standard: 

 Slot Mill 

 Dove Tail 

 Corner Rounding 

 Thread Mill 

Previously, these tools required a license for the Advanced Tools 
module. 

 

Setup sheets 

Setup sheets are used to provide specific instructions for operators 
who run generated NC programs on machines. In PartMaker, setup 

sheets are created in HTML format (using a Setup Sheet template) 
and can be printed out or viewed online. 

 Setup sheets are not available in PartMaker/WireEDM. 

PartMaker 2011 includes several enhancements to Setup sheets. 
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Include mid-processing cutting pictures in Setup sheets 

If you are using a Setup Sheet template that supports mid-process 
cutting pictures, you can use the Part View options on the Generate 

Setup Sheet dialog to include pictures of the part being machined at 

each step in the machining process. 

 The default template, PRS_process_pictures.html, provided with 

your PartMaker installation, includes support for mid-process 
cutting pictures. 

Including mid-process pictures shows exactly how the part should 
be machined and so can reduce setup time and reduce the 

possibility of errors. 

You can choose whether to display the cutting pictures in Standard 

or Isometric views, with or without toolpaths shown. The following 
example shows cutting pictures in Standard view, with no toolpaths 

shown: 

 

Setup sheet templates 

PartMaker 2011 includes several new Setup Sheet templates, as 

well as improvements to existing templates. 
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New Setup sheet parameters 

PartMaker 2011 includes several new Setup Sheet parameters for 

use in templates. These are: 
 
{work-shift} 

{material-file-name} 

{collet-nose-ext} 

{process-id} 

{work-offset-main} 

{work-offset-sub}{work-shift} 

{material-file-name} 

{collet-nose-ext} 

{process-id} 

{work-offset-main} 

{work-offset-sub} 

{part-picture} 
 

Working with solids 

PartMaker allows you to import a solid 3D model of a part. Once a 

model has been imported you can extract geometry from the model 
and/or program directly on the solid model itself. 

 To import solid models into PartMaker you must have licensed 
the Solids Import module. 

PartMaker 2011 includes the following enhancements for working 
with solid models: 

 A new option on the Solids Options dialog allows you to choose 

whether you want to view the profiles and holes from all Face 
windows on the solid model, or whether you want to view only 

those profiles and holes from the active Face window: 

 

If you choose to view profiles and holes from all Face windows on 
the solid model, clicking on a profile or hole on a solid model 

makes the Face window in which the profile or hole is 
programmed the active window. It also makes the work group 

containing the profile or hole the current work group. 
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 A new option on the Toolpath Verification dialog allows you to 

specify whether you want to verify every toolpath in every Face 
windows, or only those in the active Face window: 

 

 PartMaker 2011 is now compatible with the following types of 
files: 

 SolidWorks 2011 

 Parasolid v23.0 

 ProE/Wildfire-5 

 PartMaker 2011 uses a new configuration procedure to complete 

the installation of the Pro/E import module. This procedure is 
documented in the \PM-

Common\Documents\proe_installation_instructions.doc file, which is 

installed in your PartMaker User Files folder. 

 PartMaker 2011 no longer provides AutoDesk Inventor View on 

the PartMaker CD. Users of AutoDesk Inventor View need to 
follow the download instructions in the \PM-

Common\Documents\Read_Inventor_Installation.txt file, which is 

installed in your PartMaker User Files folder. 
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Working with notes and dimensions 

Notes and dimensions provide a useful way of annotating geometry 
when working in CAD model. PartMaker 2011 includes several 

enhancements to the way in which you can use notes and 
dimensions: 

 Ability to use user-defined fonts for notes and dimensions added in 

CAD mode: 

 

 Ability to view notes and/or dimensions in CAM mode, as well as in 

CAD mode: 

 

 Ability to convert notes into profiles for engraving in 

PartMaker/SwissCAM, PartMaker/Turn-Mill and PartMaker/Mill by 
creating a note (see 1), selecting a menu option (see 2) so that 

PartMaker creates a profile and adds it to the current profile 

group (see 3): 
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Simulation 

PartMaker's simulation features allow you to visualize the part you 
have programmed being machined,  so you can identify any errors 

before the part is machined. 

PartMaker 2011 includes the following enhancements to simulation: 

 Quicker simulation for complex 4-axis and 5-axis milling. 

 Simulation of Pinch Milling in M2S0 mode is now available in 

Basic, Advanced and Full Simulation. 

 Ability to sort holders alphabetically when selecting holders for a 

Full Machine Simulation file: 

 
 

Programming sub-spindle faces using 
Mill ZY Plane 

PartMaker 2011 changes the way in which sub-spindle faces are 
handled when programming in a Mill ZY Plane, so that 2D geometry, 

profiles and holes are mirrored with respect to the Z-Axis (the signs 
of Y coordinates are inverted). PartMaker automatically applies this 

behavior when you transfer geometry from a solid model or when 
you program directly on a solid model. 

This change resolves a discrepancy in earlier versions of PartMaker, 
where a toolpath appeared on one side of a profile in the 2D Face 

window and on the other side of the profile in the Solids window. 
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As a result of this change, toolpaths created in earlier versions of 

PartMaker will change as follows when used in PartMaker 2011: 

 Arc directions are reversed (for example, clockwise to counter-

clockwise). 

 Tool positions change sides (for example a tool position of Left 

becomes Right). 

When you open an old job file (created prior to PartMaker 2011) 

containing a sub-spindle face programmed using the Mill ZY Plane in 
PartMaker 2011, PartMaker displays a message informing you that 

the job file will be converted to use the new programming behavior.  

 Please check all sub-spindle Mill ZY toolpaths to ensure that 

the conversion follows your desired tool motion. 

 Once a job file has been converted, do not use that file with 
earlier versions of PartMaker. 

 

Surface Machining Wizard (SMW) 

The Surface Machining Wizard (SMW) implements toolpath 
machining strategies for milling free-shape surfaces. It is an 

optional module that can be licensed for PartMaker/Mill, 
PartMaker/Turn-Mill and PartMaker/SwissCAM.  

PartMaker 2011 includes the following enhancements to the 

Software Machining Wizard (SMW): 

 New Surface Swarf Finishing strategy added, which allows the 

swarfing of selected surfaces without the need to create swarf 
profiles: 

 

 Quicker calculation time for very long surface machining 
toolpaths. 
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PartMaker/PowerMILL interface 

PRODUCT>'s interface to PowerMILL allows you to import toolpaths 
programmed in PowerMILL directly into PartMaker, so you can take 

advantage of PowerMILL's complex machining strategies within 
PartMaker. 

PartMaker 2011 includes the following enhancements to the 
PartMaker/PowerMILL interface: 

 Improved performance, including faster simulation and faster 
import of toolpaths. 

 Toolpaths that have not been fully calculated in PowerMILL are 
no longer imported into PartMaker. 

 Improved zooming when using the PowerMILL Viewing style, so 
its behavior matches the zoom feature in PowerMILL. 

 New pictures of cutting strategies on the PowerMILL Toolpath 

Group Parameters dialogs. 

 PartMaker 2011 is compatible with projects created in 

PowerMILL v2011 and lower versions. 
 

General improvements 

PartMaker 2011 contains the following general improvements: 

 Numbers are now displayed with up to eight decimal places for 

improved precision. 

 New Optional Pass option on Profile Group Parameters dialog for 

pockets: 

 

 Improvements to the toolpath calculations for: 

 Rough Turning toolpath when using different X and Z Finish 

allowances. 

 Turning toolpaths with a Cycle Type of Contouring for profile 

curves containing small fillets when the Corner Rounding 

option is not selected in the Defaults for Turning dialog. A small 

fillet is defined as an arc, where the radius is less than  

[Tool Nose Radius + Finish Allowance]. 
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 Milling toolpaths with a Cycle Type of Contour Mill, where the 

profile curves contain small fillets when the Corner Rounding 
option is not selected in the Defaults for Milling dialog. A small 

fillet is defined as an arc where the radius is less than  

[Half of Tool Diameter + Finish Allowance]. 

 Additional import and export options for improved compatibility 

with other CAD/CAM systems: 

 New File > Import > DWG File option to import AutoCAD 

Drawing (.DWG) files. 

 New File > Export > DGK File option to export a solid model to 

.DGK format, which is suitable for use with other Delcam 

applications. 

 File > Import > STEP File option is now available as standard to 

customers who have licensed the Solids Import module, and 

does not require separate licensing. 

 Various improvements to the user interface, including new 

product icons and an updated look-and-feel for the help that is 
consistent with other Delcam products. 

 

ConfigPost 

PartMaker uses Post files to convert processes in the Process Table 
into NC program code. Using ConfigPost you can create and save 

custom Post files. 

ConfigPost 2011 includes the following enhancements: 

Reserved words 

The following reserved words have been added: 

 <cut-off-sub-grip-z> 

 <first-face-use>  

 <inclined-tool-region> 

 <sub-spindle-distance> 

 <sub-spindle-orient> 

 <total-c-angle> 

Refer to the ConfigPost online help for more information about any 

of these reserved words. 
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General Information, Mill dialog 

Some of the values for the 5-Axis Simultaneous Milling drop-down list 

box on the General Information. Mill dialog have changed as follows: 

 (X,Y) Before C-Angle Rotation is now (X,Y,Z) in Rotating Coordinate 
System 

 (X,Y) After C-Angle Rotation is now (X,Y,Z) in Machine Coordinate 
System 

 



 

20 • Help and support  PartMaker 2011  

If you are a new PartMaker user, you may want to use the following 

resources to help you get started: 

 Help and documentation (see page 20). 

 Training (see page 20). 

If you experience any problems when installing or using PartMaker, 

contact technical support (see page 21). 

If you require any modifications to the Distribution Post files you 

have licensed, refer to the Post Processor modification policy (see 
page 22). 

 

Help and documentation 

To help you get started, PartMaker is supplied with a comprehensive 
online Reference Help, which you can access from the Help menu. 

Further documentation is also provided on the PartMaker 

Documentation CD.  

You can also download documentation from the Delcam Customer 

Downloads Center (http://updates.delcam.com/login.php), as 
described in Technical support for PartMaker (see page 21). 

 

Help and support 

http://updates.delcam.com/login.php
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Training for PartMaker and ConfigPost 

A wide variety of PartMaker and ConfigPost training programs are 
available from PartMaker, Inc., Delcam plc and their sales agents. 

For details of the training provided by: 

 PartMaker, Inc, see the Training section of the PartMaker website 

(http://www.partmaker.com/general/training.asp.). 

 Delcam plc, see the Training section of the Delcam website 

(http://www.delcam.com/general/about.training.asp). 

 Delcam plc sales agents, contact your sales agent directly. The 

Delcam website contains a list of sales agents and their contact 
details (http://www.delcam.com/general/about/resellers.asp). 

 

Technical support for PartMaker 

Customers with an annual maintenance agreement can obtain 

technical support for PartMaker. This support may be provided by 
phone, email or by accessing technical support information available 

on the Internet. 

Before contacting technical support, please refer to the 

documentation and help supplied with PartMaker to see if you can 
find information to solve your query.  

Internet support 

You can also access software releases, documentation, technical 
notes and videos from the Delcam Customer Downloads Center 

(http://updates.delcam.com/login.php). 

Phone and email support 

If you are unable to resolve your query, make sure you do the 

following before contacting technical support: 

 You know the name and version of the PartMaker product you 

are using. 

 You are able to describe the problem in detail. You may find it 

useful to document exactly what happened. 

 If possible, be sure you can  reproduce the problem. A support 
technician may ask you do this while you are on the phone. 

http://www.partmaker.com/general/training.asp.
http://www.delcam.com/general/about.training.asp
http://www.delcam.com/general/about/resellers.asp
http://updates.delcam.com/login.php
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 Be prepared to submit job (.job), tools (.tdb), cycles (.cdb) and 

Post Configuration files (.pst and .sub), as well as sample NC 

programs as attachments to an email message Always try to zip 

your files using the WinZip program to make it easier and 
quicker to send the files by email. 

 PartMaker will automatically zip the files if you use the Help-

> Technical Support option within PartMaker and select the 
Send Files button.  

To contact your local provider of technical support: 

 For PartMaker, Inc in the United States, email 
support@partmaker.com or phone 215-643-5077. 

 For Delcam plc in the United Kingdom, email 
support@delcam.com or call 0121 683 1010. 

 For other countries, contact your local sales agent. Contact 
details for Delcam sales agents are available on the Delcam 

website (http://www.delcam.com/general/about/resellers.asp). 
 

PartMaker post processor modification 
policy 

To request modifications to a post processor (Post) file supplied with 

PartMaker, contact technical support (see page 21) to request a 

Post Modification Request (PMR) form. You should then complete 
the form with details of the modification(s) you require. 

Modifications to post processor (Post) files fall into the following 
categories: 

 Error Correction: Technical support is provided to correct any 

error in post processor output reported on a Post Modification 

Request (PMR) form by customers with a current maintenance 
agreement. 

An error is defined as any post processor output (or lack thereof) 

that causes the machine to alarm or output that does not 
machine the part correctly, as shown by PartMaker's simulation 

and verification features. This work is provided, without charge, 
to customers with an annual maintenance agreements. Error 

corrections take priority over other types of PMRs. 

http://www.delcam.com/general/about/resellers.asp
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 General functionality improvements: These are changes that 

improve the overall functionality of the Post file for all PartMaker 
users, not just a single customer. Functionality improvements 

add functionality to a post processor to complete areas of a 
machine-specific addendum that have not yet been 

implemented, but are supported by the machine and are 
available in PartMaker’s user interface. For example: 

 A specific machining function face window. 

 A specific canned cycle. 

 A specific synchronous mode of operation. 

 A specific material control process. 

 Support of user-specific attachments does not fall into the 

category of general functionality improvements. 

General functionality improvements requested on a PMR form by 

customers with a current maintenance agreement are provided 

free of charge. 

 Tailoring to user-specific requirements: Tailoring (or "tweaking") 

post processor output to user-specific requirements applies to 
fully functional, correctly working post processors. Modifications 

in this category reflect your specific programming preferences, 
which are usually related to the style or format of the output 

being produced.  

Delcam encourages customers to use ConfigPost (ConfigPost/Lite 

should be sufficient in most cases) to make user-tailored 

modifications on their own. Customers who are unfamiliar with 
ConfigPost/Lite should arrange for training in how to use this 

program. Technical support that provides advice on how 
customers can make such changes using ConfigPost/Lite is 

provided to customers with a current annual maintenance 
agreement who have received training in how to use 

ConfigPost/Lite. 

 Post processor customization by PartMaker, Inc: Post processor 

modifications that do not fall into any of the categories above are 

classified as post processor customization. These are usually 
extensive changes that cannot be expressed using a PMR. Adding 

accessories, such as a robot arm or a measuring probe, could 
require a customized post processor. If you want PartMaker, Inc. 

to create a customized post processor, contact your sales agent 
with details of your requirements to obtain a cost estimate for 

the work. Any customization work is scheduled based on the 
urgency of the request and availability of personnel.  
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